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Selecting Loudspeaker Models, Modules and Beam Patterns

Is the MSA12X the Right Choice for the Application?

When considering the Panaray® MSA12X modular steerable array loudspeaker vs. the passive Panaray®
MA12EX modular line array loudspeaker, the MSA12X would be a good choice in the following scenarios:

Rooms that need a columnar loudspeaker installed vertically and tight-to-the wall for improved
aesthetics, allowing the loudspeaker to visually blend into the room. Panaray MSA12X arrays do not need
mechanical aiming, or pitch. They can also be mounted high on the wall, using digital steering to focus
sound down to audience areas.

Difficult rooms with high reverberation times that need the radiation pattern control offered by digital
beam steering. MSA12X arrays allow more precise targeting of audience areas, so you can decide where
you want to place (and not place) the acoustic energy. This level of control leads to better direct-to-
reverberant sound ratios and speech intelligibility in difficult rooms.

Rooms that require two audience zones to be covered by a single-column array.
Rooms that need a columnar loudspeaker recessed into surfaces.

Rooms with structural or design constraints that require the loudspeaker to be installed in non-ideal
locations.

Rooms that do not have an amplifier rack and can benefit from using a powered loudspeaker.

Rooms that already use, or are planning to use Dante® digital audio and control over Ethernet-based
networks.
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Selecting Loudspeaker Models, Modules and Beam Patterns

Choosing Between 1, 2 or 3 Modules
When choosing the number of modules of an array, there are many elements to consider.

Max SPL, Throw Distance and Beam Control of Low-Frequency Content

The longer the array, the higher the maximum SPL and the longer the throw distance. Also, longer arrays can
vertically and digitally steer audio content down to a lower frequency, as indicated by Beam Control Limit.

The table below is a guide for these items:

Typical Usable bilese SPLS Beam Control
Modules Throw Distance' 1°m 0m LF Limit
1 10 m (33 ft) 97 dB 91 dB 88 dB 500 Hz
2 25 m (82 ft) 100 dB 96 dB 94 dB 250 Hz
3 35 m (115 ft) 101 dB 97 dB 95 dB 160 Hz

"Typical Maximum Usable Throw Distance includes considerations for reverberation and speech intelligibility.

2Max SPL calculated based on free-field (no boundary loading gain) sensitivity, exclusive of power compression, and without beam
steering, spreading or smoothing functions applied.

All calculations based on typical conditions with complex acoustic summation by Bose Modeler® software; many competitor specifications
based on less accurate, distance-loss approximations.

For applications that exceed the general guidelines listed above, use Bose Modeler® to predict SPL for a specific acoustic environment, or
contact your Bose Professional representative.

Conference rooms with lower ceilings and smaller steering angles may not have the same reverberation concerns and can mainly consider
Max SPL as a guiding factor for choosing between 1, 2 and 3 array modules.

Array Location (Height)

If you mount the array high on the wall and utilize a more significant steering angle closer to -20° and a wide
spreading angle to cover the front rows, a 2- or 3-module MSA12X configuration is highly recommended.

Dual Beam Mode

When using Dual Beam mode, it is recommended to use a 2- or 3-module MSA12X array for better pattern
control due to the longer array.

Reverberant Spaces

Generally, the primary use of columnar arrays are for speech reproduction. Also, most of these applications
tend to be highly reverberant spaces.

The rule for these venues is, as reverberation time increases, stack more modules.

. * These recommendations apply to “typical” medium sized venues with some rever-

*
RT60* for Medium beration concerns. In cases where your application exceeds the guidelines, design
to Large Venues tools such as Modeler software, should be used to determine system performance.

1 module 1.5 sec

2 module 3.0 sec

3 module 5.0 sec
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Selecting Loudspeaker Models, Modules and Beam Patterns

Choosing Beam Patterns

There are three beam pattern options for the Panaray® MSA12X. You can choose the beam type depending on
the location of the array and shape of the coverage area.

Basic Steer/Spread

Basic Steer/Spread is the most basic beam pattern. First, steer the axis of the
beam vertically, then spread the beam from that axis. Steering and Spreading

are independent from each other. If spreading is applied, the beam is spread
symmetrically from the steer axis. When the Steer angle = O and the Spread
angle = O, the radiation pattern of the array is the same as that of a (passive) non-
steerable columnar array, such as the Panaray MA12EX loudspeaker. Steer/Spread
works for the vertical plane only; horizontal steering/spreading is not supported.

Vocal Range Smoothing Option

Basic Steer/Spread has an option called Vocal Range Smoothing. With this option enabled (ON), the tonal
balance inside of the coverage becomes more consistent, and the sidelobes from the beam are suppressed.
The beam shape also becomes smoother, specifically around the vocal range. The trade-off of using this
option is that you lose a few dB of headroom.

Angular Limits

1-module array 2- or 3-module array

-20°

Steer: £ 20° Steer: £ 20°
Spread: Up to 30° (+ 15°) Spread: Up to 40° (+ 20°)
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Selecting Loudspeaker Models, Modules and Beam Patterns

Flat-Floor Optimized

As the name suggests, Flat-Floor Optimized is a beam pattern that is optimized

for flat floors. With this beam type, you can only steer the beam. Spreading is

not available in this pattern. This beam type achieves consistent coverage from \
the front row to the back row of the room, specifically around the vocal range. |:|

Keep in mind that this beam pattern works best when the array is mounted at a —_

certain height: The bottom plate of the array should be mounted 0.3 to 0.8 m (1 I ————

to 2.5 feet) above the ear height of the audience. If the array is mounted higher
than this, or the floor is raked, choose a different beam type.

Vocal Range Smoothing Option

The Flat-Floor Optimized beam pattern also has an option called Vocal Range Smoothing. With this option
enabled, the tonal balance from front to back of the room becomes consistent around the vocal range, and
the sidelobes from the beam are suppressed. Again, the trade-off of this option is that you lose a few dB of
headroom. This feature is ON by default and recommended for this beam type.
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Selecting Loudspeaker Models, Modules and Beam Patterns

Raked-Floor Optimized

As the name suggests, Raked-Floor Optimized is a beam pattern that is

optimized for raked floors. The Raked-Floor Optimized beam type achieves a \
vertically-asymmetrical beam radiation, which is suitable for covering a raked

floor, or covering a flat floor from a relatively high array position, such as when \

the bottom plate of the array is more than 1 m (3.3 feet) above the ear height
of the audience.

This pattern does not offer the Vocal Range Smoothing option.

Dual Beam Mode

Up to two beams can be radiated from an MSA12X array built from 1, 2 or 3 modules, with any beam pattern
selected independently for each beam. You can also apply individual gain and Room EQ* for each beam.

Note: Dual Beam Mode is only available when using Dante® input.

Dual beams for the MSA12X is achieved by utilizing all the drivers of the array for both beams simultaneously.
By utilizing all the available drivers, better low-frequency directivity control for both beams can be achieved.
Other manufacturers may split their array into 2 smaller arrays (one on top of the other) to achieve dual
beams, but at the cost of performance.

* Supported Bose® ControlSpace processor with Dante card required to apply individual room EQ for each beam

Dual Beam Mode, using Basic Steer/Spread and Raked-Floor Optimized
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Modeler Properties and Operation

Modeler® Properties and Operation

Beam pattern design starts using Bose® Modeler software. In Modeler, you can look at the coverage both

on the horizontal plane and the vertical plane in real time, and adjust the beam shape to match the room.
You can also specify parameters for the Basic Steer/Spread beam type within ControlSpace® Designer™
software (CSD) directly, without needing Modeler. Refer to the “Setting Up MSA12X Basic Beam Steering and
Spreading” topic in the CSD help system for more information.

Note: Room modeling using Modeler software is not covered in this document. For room modeling, refer to
Modeler help materials.

Place Array
Select ‘Place MSA Array’ Tool.
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DM~ RS ? DEKL #- v 868
M v o g8 i B @ | vy @ Selection: None d
" Mede Place MSA Array
VA

m[ﬂ, L [-20 |15 10 /s 0 |5 |10 15 [20 |25
o - o

| o)
=
?

]
¥
@

ki
- =
»

’ 2

Click the surface in the Plan view and place an array.
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Modeler Properties and Operation

Yaw the array if necessary. Select the blue arrow of the array aiming tool and move.
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Click and select the array. Go to the Properties tab in the Detail View.
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Change the array mounting position (height) in the Array Position frame. Center is the Z-coordinate of the
array center; Top is the MSA12X top plate; Bottom is MSA12X bottom plate.
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Modeler Properties and Operation

Array Tab
Basic properties of the array are set In the Array tab.

| Aray Beam Map

Array Fosition Array Configuration

Top: 3785 m bModules: |2 - Eeams: ® Single ¢ Dual

Diante Onl
Center; | 2800 I ( )

Batom: 1815 m Arrayy Name: |hain Left

Comments:
()

Yeaw: | 0.00 Weekday, covering main flaar anly

= Simulatinn] Yy Surfau:es] H Dnnrs;"'n’l.l'indnwsl I3 Loudspeakers] & Listeners Properties | + EQ] 2] .ﬁa:nustiu:s]

Array Position

Top/Center/Bottom: Set the Z-coordinate of the array. Center is for the array center; Top/Bottom are
for top/bottom plate of the array. Top/Bottom are linked to the Center. You can use the Top/Bottom
coordinate to specify the mounting height on site. Note that this is the Z-coordinate of the model, which
may not necessarily be the distance from floor (when the Z-coordinate of the floor is O, they match).

Yaw: Set the yaw of the array.
Array Configuration
Modules: Specify the number of the modules in an array. Select from 1, 2 or 3.

Beams: Specify the number of the beams radiated from the array. Either Single beam or Dual beams.
Note: For the actual system, Dual beams are possible only using the Dante® input.

Array Name: You can name the array, such as ‘Main Left’. This name is used to manage the link between
Modeler and CSD later in the workflow.

Comments: This field can be used to describe the beam pattern (e.g. ‘Weekday, covering main floor only’,
‘Sunday, covering main floor + balcony’). The comments chosen in this field are indicated in CSD later in
the workflow. This can be useful when comparing multiple beam patterns for an array rather than looking
at parameter values (e.g. Steer -10°, Spread +10°).
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Modeler Properties and Operation

Beam Tab

In the Beam tab, you can specify the beam type and beam parameters.

| Amay ||Bean1 | Map |

—Beam
I_. Parameter Value Units
hain | Znd ‘ Steering 5.0 | () |

Spreading a8 ")

ain Gain (0.0 dE Smoothing off |
Top !/ Rear Dist. 17.0 m

Znd Gain ID-D dB Top / Rear Angle 22 )
Bot/ Front Dist. 5.0 m

[ Steer/Spread [=]| Bt FromAnee a4 0 Send To CSD |

=P Simulationl T Surfacesl H Doorsf"n'lﬁndowsl [ﬂ Loudspeakersl 8 Listeners Properties I + EOI 5 Acousticsl

Main/2nd: Selection for Main beam or Secondary beam. ‘2nd’ beam tab appears only when ‘Dual beam’ is
selected in the Array tab.

Main Gain/2nd Gain: Beam gain for main beam and second beam. ‘2nd Gain’ is grayed out when ‘Single
beam’ is selected in the Array tab.

Beam type selector: Select beam type from the drop-down box.
Beam parameters: Parameters to specify the beam shape.
Send to CSD: A button to export the computed beam coefficients to CSD.
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User Interface for Beam Shaping

User Interface for Beam Shaping

Basic Steer/Spread

[ElC T 01z [ 14 [ 16 [ [6 [ [0 [42] [14 [ [46 [ [da [=13 _do-5PL
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ﬁ Web | [ Model Direct |

Array ||Beam | Map |

~Beam

IM—| Parameter Value | Units. |
G Steering 50 )

Spreading 20.0 ")

kdain Gain (0.0 dB Smoothing On -~
Top / Rear Dist. 17.5 m

2nd Gain I dB Top / Rear Angle 33 )
Bot/ Front Dist. 16.5 m

[ Steer/Spresd [ | 2/ oM ANSe 150 0 Send To CSD |

=5 Sirnulationl B Surfacesl H Doors,-"Windowsl H Loudspeakersl B Listeners Properties | + EQI 2] .Rcousticsl

Select Steer/Spread from the beam type drop-down selector. With this beam type, the beam axis can be
steered vertically, and the beam can be spread symmetrically from that axis. You can adjust the beam shape
with one of the following:

A: Enter Steering/Spreading angle values in the cell (Positive steering angle aims the beam upward).

B: Select and move the edges of Top (Rear) throw line and Bottom (Front) throw line on the Vertical
Coverage Map.

C: Enter the distance and angle values of the above throw lines in the cell.
A, B and C are linked and are automatically updated when the beam shape is changed.

When you move the edges on the Vertical map, select the Top (Rear) throw line edge and move to the target
point of far throw. Remember to take the ear height of the far-end listener into account. Repeat the same for
the Bottom (Front) throw.

Note: A sum of Top/Rear Angle and Bottom/Front Angle may not necessarily be the same as the Spreading
angle. This is because Modeler is adjusting the Steer/Spread angle to effectively cover the far throw target
point.

Each Beam type has its own limitation for the Beam Parameters. For example, you cannot spread the beam
too wide with Basic Steer/Spread. When you drag the edge, observe the color of the circle of the line edge; if
it is green, the edge is within the limitation. When it turns red, it is outside the limitation and the edge snaps
back to the original position.
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User Interface for Beam Shaping

| |
r [
L T— R
: ' —‘-T-—_..
Within the limitation (green) Outside of the limitation (red)

Vocal Range Smoothing Option: Select either ON or OFF. With this option ON, the tonal balance inside the
coverage becomes more consistent and the sidelobes from the beam are suppressed and the beam shape
becomes smoother, specifically around voice range. The trade-off of this option is that you lose a few dB of
headroom. By default, Vocal Range Smoothing is OFF with Basic Steer/Spread.

Flat-Floor Optimized

Ei’sa o T T7= [ [ [ [ [ [5 [ [0 [d42 [ [44 [ [46 [ 48 [0]=19  dB-5PL
@ 0 = [1o B [20 [z
il B
-
»
= -
o
’|
o
=] -
4
» 2] Web | [ Model BF] Diect |
Amay ||Beam ‘ Map |
Beam
IM—| Parameter Value | unite |
il Steering EX) )
Smoothing On j
Iain Gain (0.0 db Top / Rear Dist 52 m
. Top / Rear Angle -5.0 )
2nd Gain I dB Bot/ Front Dist. 29 m
Bot/ Front Angle -24.3 %y
Flat Floor B
= imulaﬂonl T Surfaml H Doorsal‘w‘lndowsl Dﬂ Loudspeak.elsl &8 Lsteners Pmped_iesl = EI}I 5] Acounlcsl

Select Flat Floor from the beam type drop-down selector. This beam type is optimized for a flat-floor seating
arrangement. With this beam pattern, you can only steer the beam vertically, without any spreading. This
beam type can deliver consistent coverage from front to back specifically around the vocal range when the
array location (height) is appropriate, but if the array is located too high, you may not be able to achieve the
coverage you expect. Make sure the Bottom plate of the array is located 0.3 to 0.8 m (1to 2.5 feet) above the
ear height of the audience.
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User Interface for Beam Shaping

Max Recommended
0.3-0.8 m
(1-2.5")

The beam shape can be adjusted with one of the following:
A: Enter Steering angle value in the cell (Positive steering angle aims the beam upward).

B: Select and move the edges of Top (Rear) throw line and Bottom (Front) throw line on the Vertical
Coverage Map.

C: Enter the distance and angle values of the above throw lines in the cell.
A, B and C are linked and are automatically updated when the beam shape is changed.

When you move the edges on the Vertical map, select the Top (Rear) throw line edge and move to the target
point of far throw. Remember to take the ear height of the far-end listener into account. You can move the
Bottom (Front) throw line edge but it does not affect the beam shape.

Note: The Top/Rear Angle and Steering Angle may not necessarily be the same. This is because Modeler is
adjusting the Steer angle to effectively cover the far throw target point.

Each Beam type has its own limitation for the Beam Parameters. When you drag the edge, observe the color
of the circle of the line edge; if it is green, the edge is within the limitation. When it turns red, it is outside the
limitation and the edge snaps back to the original position.

Vocal Range Smoothing Option: Select either ON or OFF. With this option ON, the tonal balance inside the
coverage becomes more consistent, and the sidelobes from the beam are suppressed and the beam shape

becomes smoother, specifically around voice range. The trade-off of this option is that you lose a few dB of
headroom. By default, Vocal Range Smoothing is ON with Flat-Floor Optimized.
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User Interface for Beam Shaping

Raked-Floor Optimized
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Top / Rear Angle 25 "y
Main Gain |00 dB Bot / Front Dist 73 m
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Select Raked Floor from the beam type selection. This beam type achieves a vertically asymmetrical beam

radiation, which is suitable for covering a raked floor, or covering a flat floor from a relatively high array
position.

The beam shape can be adjusted with one of the following:

A: Select and move the edges of Top (Rear) throw line and Bottom (Front) throw line on the Vertical
Coverage Map.

B: Enter the distance and angle values of the above throw lines in the cell.

A and B are linked and are automatically updated when the beam shape is changed.

Each Beam type has its own limitation for the Beam Parameters. For example, you cannot spread the beam
too much with Raked-Floor Optimized. When you drag the edge, observe the color of the circle of the line

edge; if it is green, the edge is within limitation. When it turns red, it is outside the limitation and the edge
snaps back to the original position.

Within the limitation (green) Outside of the limitation (red)
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User Interface for Beam Shaping

Dual Beam Mode
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Dual Beam mode radiates two beams from a MSA12X array. When you have selected Dual in the Array tab
(see page 11), a 2nd tab appears for the secondary beam. You can choose any of the three beam types for
each beam (Main beam and Secondary beam) independently. You can also apply beam gains for each beam

to balance the level at the seating area.

By selecting the ‘Main’ and ‘2nd’ tab, the beam type selection and corresponding parameters displayed are

switched.

Note: Dual beam is only possible by using the Dante® input with the actual system (Modeler does not have
property to set the input type). When saving Modeler steering in CSD with Dual Beams, ensure Dante input is

selected before saving.
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User Interface for Beam Shaping

Map Tab
The Map tab is used for changing the properties for SPL mapping.
Amay | Beam || Map |
~hap
[ Salo

V¥ Room

¥ “ertical Map

¥ Translucent

= Simulatinnl T Surfacesl H Doorsﬂ.’lﬁndowsl I Luudspeakersl & Lsteners Properties | + EQl 25} .ﬂmusticsl

Solo: Mutes/Unmutes the array and loudspeakers in the model.

Vertical Map: Activate/Deactivate the Vertical Map.

Room: Activate/Deactivate the SPL map for the room surfaces specified in the Simulation tab.

Translucent: Activate/Deactivate the Translucent option for the SPL map.

Send to CSD
Armay ||Eearn | Map |
—Beam

IMain |
kdain Gain 0.0 dB

Znd Gain I dB

Parameter

Walue

| Steering

—_
[~o——
el
e,

ISteerfSpreadE

Spreading
Smeothing

Top ! Rear Dist.
Top / Rear Angle
Bot/ Front Dist.
Bot/ Front Angle

0.0
0.0
Off
251
0.0
49
0.0

= Simulationl Ty Surfacesl H Doorsﬂ'\ﬁndowsl I3 Loudspeakersl B Listeners Properties I + EQI 2] Acousticsl

When you finish the beam shape design in Modeler, and save the file, the next step is to transfer the data that
Modeler computes based on your setting into ControlSpace Designer software (CSD).

Launch CSD. Return to Modeler and select the Beam tab again. Then, click the ‘Send to CSD’ button on the far

right.

Note: CSD must be open and running on the same machine as Modeler for the data transfer to work. Ensure

you have CSD 5.0 or

later.

Send To CzD |
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Manage Multiple Beam Patterns

If you have a select Bose® ControlSpace® processor in your system (see table below), you can set multiple
beam patterns in an array and set up end user recall of these settings.

Below is the process to keep each beam pattern in a Modeler .mdr file:
1. Name the Array Name (e.g. ‘Main Left’) in the Array tab.

2. Design the beam shape (pattern A) and add short description of the beam in the ‘Comments’ field (e.g.
“Weekday, covering main floor only”).

3. Save the .mdr file with an appropriate name (e.g. ‘Weekday.mdr’).
Duplicate the .mdr file and rename (e.g. ‘Sunday.mdr’).

5. Design the beam shape (pattern B) for the same array and change the short description in the ‘Comments’
field (e.g. “Sunday, covering main floor and balcony).
Note: At this point, the Array Name and number of modules of the array should be the same as before.

6. Save the .mdr file.

Later in the workflow, we link the array in Modeler and the actual array through ControlSpace® Designer™
software, and as long as the array name and number of modules are the same, we can maintain that link for
different beam patterns stored in multiple .mdr files.

Supported ControlSpace Processor Models

ESP-880
ESP-1240
ESP-4120
ESP-1600
EX-1280C
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Array Setup

Wiring
When you mount a MSA12X, you can choose the orientation: Control from Bottom or Control from Top.

Once you mount the array, you have to specify the orientation in ControlSpace® Designer™ software (CSD),
otherwise the beam could point toward the ceiling!

RJ-50
(Expansion)

RJ-45 RJ-50
(Ethernet) (Expansion)

.l}@ﬁ

Control
(Ethernet)
=
Power
Control
(Ethernet)
=
Power

ol A

- 'm
P

RJ-45 RJ-50 RJ-50

(Ethernet) (Expansion) (Expansion)

Control from Bottom Control from Top
(Default Orientation)
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You can configure a longer array by stacking multiple modules and connect the modules by an expansion
cable. Up to a 3-module array is supported. The end connectors of an expansion cable are RJ-50 (cable
supplied), which is different from the RJ-45 for Control/Dante® (Ethernet), although they look similar. Take
notice when setting up a multi-module array.

For a multi-module array, the Ethernet cable has to be inserted to the receptacle located at the end of
the array, and the module in which the Ethernet cable is inserted becomes the Master module of the array
automatically. Audio signal and control signal are passed to the slave module(s) via the RJ-50 expansion
cable between the modules. You cannot insert the Ethernet cable into the modules other than the one
mentioned above. The array does not work when you insert the Ethernet cable into the wrong modules.

Ethernet
_—_
RJ-45 Master
Module
Expansion Expansion
Expansion ) Expansion )
Master
Ethernet Module
_—
RJ-45
Control from Bottom Control from Top
v Good v Good
Expansion
. Ethernet !
Expansion RJ45 "
Ethernet . .-
W Expansion L
|
Expansion
X No Good X No Good

The master module represents the entire array; the IP address of the master module applies to the entire
array. i.e. a multi-module array can be seen as a single device; it is just a long array with more drivers than a
single-module array.

Mounting

Refer to the MSA12X Installation Guide available on pro.Bose.com.
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CSD Properties and Operation

ControlSpace® Designer™ software (CSD) is used to transfer the beam pattern and mode (single or dual

beam) configuration to MSA12X loudspeakers.

MSA12X Device Block in Project View

Eile Edit View Iools System Window Help

RoR®xdElcoc|aam - BEHO A&

Devie Pt Project View [l 28

[=-=zm Sound Processors
- EX-1280C
- ESP-880

- . EsP-4120

o ESP-1240

.. ESP-1600

= ESP-001

[+- =l Powerlatch Amplifiers
=- Dante Endpoints

gl EX-AML

-« EX-BML

g EX-UH

. EP22-D)

. EP40-D

- 22| WP22B-D

j WP22BU-D :
iy ATHDET1 : Offline: 160
§ ~mnDsE77 Dante
-~ ATNDB734
s MXA310
B mxag10
-] msarax
[#-=_ Control Centers
[ >< Discontinued
(- ) Devices

Address: 176

Lef-Array

ESP-12401
‘Connected: 101
Dante

O

- Sunda

ESP-12401
‘Connected: 102
Dante

ENIVIEEY Ko

(]

L. e MEDa Calrrind

Anne TV 4900F ATE lad—tan: Mo nondine

When you add a MSA12X to a CSD Project, the device block appears in the Project view. There are a few ways

to add a MSA12X to a CSD Project.

On the device block, the following can be seen:
Device Name

Array Name in design (blank if not set)

Current Beam Preset

Connection status between CSD and the device
Last octet of IP address

N OO AN

Input type (Dante® or Analog)

Main-Left

ESP-4120 1 —
©—— Connected: 102 —
Dante

od

You can rename the Device Name by right-clicking (or press F2 key).

Device name of signal processor that the array is associated with (blank if not associated)
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MSA12X Control Panel
By double-clicking the device block in the Project View, the MSA12X control panel appears.

MSA12X
MSA12X 1
Array Name in design Beam Gain & EQ Status
Main Left Main Beam  2nd Beam Connected: . [ it
Standby: |:| WClip
1.0 0.0 dB
Input & Speaker EQ = Click 10 1oggle 'g
12 12 -
. -10
Input: @ Dante () Analog |(0dB  « Health: . B
[ 0 s ] -40
a0
Beam
Set Beam from CSD Set..

Beam Preset

2: Sunday ~| | store || Ciear | - )
[] Show Beam EQ
Power On State: 1: Weekday Select POS...

Dwal heam

Comments: Sunday, covering main floor and balcony

[] Show beam details

Hardware configuration: Message (See Advanced Window for Details) Advanced

IP Address: 192.158.0.142 | Set . Communication Timeout 1301

Array Name in Design
The name of the array specified in Modeler. By default, this is blank.
Input & Speaker EQ

Input: Select from Dante® or Analog, followed by the input gain. The input gain is independent between
Dante and Analog.

Speaker EQ: Select from Music or Voice.
Beam

Set Beam from CSD: You can set the beam steering and spreading without needing Modeler.
Note: This is limited to the Basic Steer/Spread.

Beam Preset
You can store/recall the beam pattern and Power On State here.
Basic beam description: Shows beam mode and comments details as entered in Modeler.
Show beam details: Indicates the detailed beam parameters specified in Modeler.
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Beam Gain & EQ
Beam Gain: Gain for each beam.

Show Beam EQ: Indicates the Beam EQ. A Beam EQ is a filter that compensates the tonal balance of each
beam corresponding to the beam shape. The filter curve is automatically computed and updated every
time the beam pattern is sent from Modeler. You can change the curve shape manually and store to a
Beam Preset.

Freq: Center frequency.
Slope: Slope of the curve.
Gain: Hi-boost gain.
Restore Defaults: Return to the setting that was originally suggested from Modeler for that beam pattern.
Bypass: Bypass the beam EQ filter.
Status
Connected: Blue, when the connection between the array and CSD is active.
Standby: Red, when the array is in Standby. You can toggle the standby status by clicking the icon.

Health: Yellow, if there is a temperature warning. Red if there is a temperature fault or a driver fault. Green
otherwise.

Limit: Yellow, when output limiter is active for the array.
Level Meter: Level of input signal after the input Gain.
Hardware Configuration

Identify: When Dante® is enabled and the device is online, clicking this button triggers a flashing LED on
the back of the array.

IP Address: IP address of the MSA12X array. ‘Set...” opens the Dante Properties window when Dante
connection is enabled.

Advanced...: Opens the Advanced Window.
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Advanced Window

MSA12X Advanced

MSA12X-0022b2

Array Controls  Audio Check Device
) Top @ Off () Internal () External Module Count: 1
_ (1 kHz) , _
Firmware Version: 1.23
4 [ | Amray -
d Module 1 [ DSP Version: 0.19.1.0
CH1 Boot Version: 1.2
CH2
CH3 Auto-Standby: | Disabled  «
- CH4
CH5 = Temperature: [ 113 ]["F v]
CHEB
CHY Faulty Drivers: [ ]
CHE
CHS
— | CH10
CH 11 m
@ Bottom _ S an - | Resetto Defauits |
Message Recover

Slave Modules...

Array Controls

When you mount an MSA12X array on the wall, you can choose the orientation of the module(s) by
specifying the array end that has the RJ-45 and power input panel. This defaults to Bottom, and in this
situation, your RJ-45 and power cables enter the master module at the bottom. In some installations,
installers prefer to send the RJ-45 and power into the top of the array. In those situations, you should
select Top from this menu; you should physically invert the array so the RJ-45 and power inputs are at
the top (and don’t forget to rotate the Bose logo on the front grille). This software setting orients the
software so it knows if the master module is on the top or bottom, which way the arrays are oriented, and
can plan the beam types and steering correctly.

Audio Check

You can check each array/module/driver with either an internal or external audio signal. With Internal
option, an internal signal generator feeds 1 kHz sine wave to the device. This is useful to identify the array
even before subscribing Dante® routing.

Device
Module Count: Number of modules of the array.
Firmware Version
DSP Version
Boot Version

Auto-Standby: You can specify the signal absence time before the array goes to Standby mode. The array
recovers from Standby mode when the input signal is present for 6-10 seconds.

Temperature: Indicates the temperature of internal amplifier.

Faulty Drivers: Indicates the number of faulty drivers and/or amplifier channels that are shorted or with
excessive high current beyond the design’s capability.

Reset to Defaults: Clears all the stored beam presets and sets the array to factory default.
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CSD Workflow

There are many different ways to configure a MSA12X system. In this document we describe an on-site setup
process. The assumption in this document is that you have an ESP with a Dante® card in the system, and the
IP address of the devices are already set. For guidance for IP setup, see Appendix.

Initial Configuration in Project View

1. Connect the PC to the network and launch CSD. A blank Project appears.

File Edit View Tools System Window Help

BOoR® xEAE >ce|/laqm -
bevkeun o x
+ - Sound Processors
# Kl PowerMatch Amplifiers
= Dante Endpoints

o EX-4ML

@ EX-3ML | evw-oo22te
@ EX-UH '
- EP22-D * (Notstored)

EEOE 08 SNy 4EadE2EBO

Project View

* (Notstored)
m— EP40-D Con%ecte: 100 Con%o.ct;(t 16
an n

=3 WP228-D

87| WP228U-D

@ ATNDOT1

. ATNDB677

I’ ATND8734

<@ MXA310

MXA910

T MSA12X
[# = Control Centers
@ X Discontinued
- 4 Devices

After 5-10 seconds (depending on the network status), MSA12X device blocks appear on the Project View.
Note: This is not related to the ControlSpace Scan. an

MSA12X is a Dante device, and it is recognized and controlled by CSD even without the CSD Network Scan or
CSD Go Online. If an MSA12X device block does not appear,

Go to System > Enable Dante Control.
Make sure the PC and MSA12X array(s) are both connected to the network.

Make sure the IP address for both the PC and the MSA12X array(s) are set properly. For details, see
Appendix.

2. ltis highly recommended to enable Endpoint Control prior to the following operations. When Endpoint
Control is disabled, Dante endpoints (including MSA12X) are under the control of the firmware of ESP
or EX-1280C, and you cannot program MSA12X controls from CSD. If Endpoint Control is disabled, many
of the controls of the MSA12X control panel will be grayed out and a warning message will be indicated.
Endpoint Control is disabled by default.

Message (See Advanced Window for Details)

Endpoint Control Disabled 1401

To enable Endpoint Control, go to System > Enable Endpoint Control.

26 - Design Guide



CSD Properties and Operation

3. The next step is to identify which MSA12X device block represents which physical array on the network. To
do this, double-click the device block and open the MSA12X control panel, and press the ‘Identify’ button at
the bottom. An LED at the back of the physical array flushes and you can identify the device block.

MSA12X

MSA12X-0022b2

Array Mame in design

Input & Speaker EQ

r:

Input: @ Dante

Beam

Set Beam from CSD

Beam Preset

) Analog

0dB -

Set...

Power On State: 1:
Single beam

Comments:

[C] Show beam details

Hardware configuration:

IP Address:

192.168.0.101 | Set..

Beam Gain & EQ

Main Beam

dB
12

0

oo

[”] Show Beam EQ

Message (See Advanced Window for Details)

Status
Connected: . O imit

standby: ||

Click 10 feggle

Healtn: ]

Advanced

If you cannot access the back of the array to see the LED, another option is to push ‘Advanced..’ button and

use the Audio Check mode.

MS5A12X Advance
MSA12X-0022b2

Array Controls

© Top

—L_
@ Bottom

d

Audio Check

(1 kHz)

@ Off ©) Internal ) External

F Array

4 Maodule 1
CH1
CH2
CH3
CH4
CHb5
CHA
CHT
CHS
CH9
CH10

CHNM
MU 172

Device

Module Count: 1

Firmware Version: 1.23
DSP Wersion: 0.19.1.0
Boot Version: 1.2

Auto-Standby: | Disabled -

Temperature: [

113 J[°F |

Faulty Drivers: [

|

Reset to Defaults

With the ‘Internal’ option, an internal signal generator feeds a 1 kHz signal to the array and the array can be

identified by that sound.
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4. Once you identify the array, rename the device, such as ‘Left-Array, ‘Right-Array. This is the device name
used for Dante® routing later. The device name can be the same as the Array name already defined in
Modeler, but they can be different.

MSA12x-0022b2 MSA12X-07T1el

Open
| Rename le\l
2 Delete DEIL"F
o Cut Crl+X
Copy Cirl+C
Duplicate Ctrl+D

You can rename the device by right-clicking the device icon in the Project View.

Note: The device name should follow the rule for Dante device labeling: Legal characters are A-Z, a-z, 0-9, and
~7(dash or hyphen). Device labels must begin with A-Z (or a-z).
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Associate ESP and MSA12X

In order to set multiple beam patterns for an MSA12X array and invoke changes from external devices, such as
a Bose CC-64 controller, you need a supported Bose® ControlSpace® processor. Then, associate the MSA12X
to the ControlSpace processor in CSD. Also through this process you can setup Dante® routing. If you use
analog for your audio signal and do not need to set/invoke multiple beam patterns, you can skip this section.

1. Scan the network with CSD Scan. @
2. An ESP device block appears on the Project View.

ESP-1240 1

& Offline: 160 [
Dante

Connected: 101 Connected: 102
Dante Dante

|y - o
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3. Double-click the ESP device block and go to the device view of the ESP. Now you see MSA12X devices in
the list under Dante Endpoints in the SP Tool Kit. Drag-drop these devices from the SP Tool Kit into the
device view. This means that these devices are associated with the ESP currently selected.

SP Tool Kit ® % | project View [+ ESP-12401
#-[g 10 Blocks

-1 LefArray

- (@ Right-Array
- g PediaRauies
1[5l Detaye o
[]-- Dynamics —
[]-- FiltersiCrossovers =

I can ‘

- [ Weters Inputs
2=} Mixers ’
[ Routers/Selectors INput7
[]--n Speaker Processing "
[]-- TestiMeasurement Input &
-8 LogiciCantrol .

Inputs

W

Input 10

Input 11

11

v

Input 12

lI

Serial In

1

4. When you drag-drop the devices from SP Tool Kit, red blocks appear in the Device View. These represent
the Dante output blocks for the MSA12X devices. Notice you have two output channels for each MSA12X
array. These 2 channels correspond to the two beams when the array is in dual beam mode; Chlis for Main
Beam, and Ch2 is for Secondary Beam. If the array is in Single beam mode, signal for Ch2 is not radiated
from MSA12X array.

SP Toel Kit

m-gd 10 Blocks

Dante Endpoints

i Audio Routes
]--- Delays

]--- Dynamics

H- LY EQs

H- @ FiltersiCrossovers
n Gain

Fl- i Meters

] Mixers

- RoutersiSelectors
) n Speaker Processing
]--- TestMeasurement
i Lagic/Control

T e [

T e b e - [

Mix out L

Mix out R

il
ﬂ

W

Input 4

Input &

5

1]

;

Input7

lI

[
[
[
[

V

Input %

W

Input 10

11

Input 11

Input 12

i
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5. Add other signal processing blocks in the Device view and complete the system. You can apply different
gain/EQ for each beam by feeding signals for output 1 and 2 of each MSA12X array.

Mix outL

Mix outR

Input 3

Input5

Inputé

Input 7

Input 8

Input 10

Input 11

Input 12

% ® B Ne e fe He Heo A O
v VOV vV Vv VvV \/

Serial In

Master Gain MainBm LEQ MainBm L Gain

> D P L
‘ 2ndBm LEQ . 2ndBm L Gain ;ﬁ
\ = >

D P

Serial O @

6. Go back to the Project View. Now the MSA12X device block indicates the ESP that it is associated with.

ESP-12401

L Offline: 160 L

Dante

Right-Armray

( EsP-12401 )
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Dante® Subscription

When MSA12X is associated to an ESP, Dante channel subscription from the ESP to the MSA12X is executed
automatically. Open the Dante Properties window by clicking the Dante icon (@) in the tool bar (or select
from System > Dante Properties...) to see that Dante channel subscriptions have already been made.

F ™ F |
E Dante Properties ﬁ E Dante Properties ﬂ

[ RELOAD DANTE INFORMATION ] [ RELOAD DANTE INFORMATION ]

Routing | Dante Properties | Emor Log Routing | Darte Properties | Emor Log

Directions: Click on cross-points to make subscriptions Directions: Click on cross-points to make subscriptions

Receiver: I Lef-Amay ;I Receiver: I Right-Amay ;I

Transmitter:

Bose-ESP-1600 (ESP-1240d

Transmitter:

Bose-ESP-1600 (ESP-124(d

— o™ —
50 a0
Chi Chi
Ch2 E Ch2
Ch3 Ch3
cha [T Chs
Chs [T Ch5
che [T che [T
ch? [T ch7 [T
che [T che [T
che [T che [T
ch10 [T ch10 [T
chl [T chil [T
chi2 [T chi2 [T
ch13 [T ch13 [T
chia [T chis [T
(&) chis [ (&) chis [
¥ Chi16 [ | ¥ chi6 [ |
b b

The Dante channel subscription can also be changed manually.

Adjust Input Settings

Adjust input settings to match your system. In the MSA12X control panel, you can
Select input type from Dante or Analog.
Select input gain (O dB / +14 dB / +24 dB).
Select Speaker EQ (Music or Voice).

Input & Speaker EQ
Input: @ Dante () Analog |0dB vl db
Speaker EQ: {Music v‘
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Send Beam Settings from Modeler®
Now you are ready to send beam settings designed in Modeler to the MSA12X arrays.

1. Go to Modeler. Select the array and go to the Properties tab. Make sure the number of Modules (module
count) in the Array Configuration matches that of the physical array.

I.Pu1—cry|Beam|Map |

—Array Fosition————————————— ~Array Configuration
Top: 3492 m rodules: |1 vl Bearns: Single & Dyal
Center: IW m {Dante Only)
Bottorn: 2508 m Array Mame: IMain Left
N E 0.00 ] Camments: |Sunday, covering main floor and balcony

= Simulationl VB SurFacesI H Doorsx‘WindowsI Dﬂ Loudspeakefsl & Listeners Properties I + EOI 2] :‘\cousticsl
2. Go to the Beam tab and click the ‘Send to CSD’ button.

Amay “Beam | Map |

Beam
Parameter ‘ Value | Units |
IME”” | end | Top ! Rear Dist. = I
Top/ Rear Angle -46 "y
kain Gain (0.0 dB Bot / Front Dist 52 m

Bot / Front Angle -29.1 (4]
2nd Gain (0.0 dB

I Raked Floar IZI

= Simulaﬁonl Ty Surfacesl H Doors/"n'h’indowsl i3] Loudspeakersl B Listeners Properties I + EQI =] Acousticsl

o~

Send To CSD i ’

3. Beam Configuration Destination dialog box appears. The arrays that are selectable in this dialog box are
the ones with the same number of modules (module count) in CSD. The number in parentheses after the

device name indicates the module count. If the module count does not match, you cannot send beam
settings to the array.

Note: CSD should have been launched on the same PC.

r - — g‘ You can select multiple devices if needed. This is helpful when
i Choose Beam Configuration Destinatio... you have multiple arrays that require the same beam settings.

Beam configuration data has been received for
a 1 module array.

Select MSA12X array(s) to receive beam data.
Left-Array (1)
(| Right-Array (1)
(| New array(s) 1 (quantity)

[ OK ] [ Cancel

Now the beam setting has been sent to the array. If you are feeding audio signal to the array, you will be able

to hear the beam pattern change. If you do not like the coverage, go back to Modeler, adjust the parameters
and repeat this process.
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Adjust Beam Gain and Beam EQ

Beam Gain & EQ Status
Main Beam  2nd Beam Connected: . CLimit
Standby:
00 d8 00 dB et L]
12 L Heatth: [
0 0
=00 -00

Show Beam EQ

15dB
12dB
9dB
6dB

|
|
)
|
'
:
|
e 4’%_‘_—
i
|
|

0dB
-3dB
20Hz 100Hz 1kHz 10kHz20kHz

Freq (Hz) Slope Gain (dB)
1259 100 & 37 %

Restore Defaults | Bypass »

The Beam Gain and Beam EQ can be changed.
Beam Gain is for balancing gains between two beams when in Dual Beam mode.
Note: Beam gain cannot be assigned to ControlSpace® wall panels, such as CC-64 or ControlSpace Remote.

Beam EQ is a filter to compensate for the tonal balance change depending on the beam spreading. The Beam
EQ curve is calculated in Modeler® for each beam automatically, and sent to CSD. The shape of the curve can
also be adjusted. By clicking the beam gain for each beam, the Beam EQ display is toggled for that beam.
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Beam Preset and Power On State

When you are satisfied with the coverage, Beam Gain and Beam EQ, the next step is to store that beam
pattern to the array. Unless you store the beam pattern to a Beam Preset, the beam pattern is lost after the
power cycle of the array. There are 10 memory banks for each MSA12X array, and you can store up to 10
different beam patterns along with other hardware properties (Beam Preset) to each MSA12X array. Beam
Preset is a ‘snapshot’ of the state of the array.

Iltems below are stored in a Beam Preset:
Input type, Input gain
Speaker EQ
Beam parameters such as Steer Angle, Spread Angle, etc.
Comments
Beam Gains
Beam EQs
Store Beam Preset
1. Click ‘Store’ button.

Beam Preset

| | store |

Power On State: 1:
Dual beam

Comments: Sunday, covering main floor and balcony

2. Store Beam Preset dialog box appears. Select the Preset number that you want to store the current state
to. Change the label for that Preset. You can also edit the Comments field (up to 50 characters).

E ~
| Store Beam Preset u

Preset: [l: v]

Label: Sunday

Comments: Sunday, covering main floor and balcony

oK l 1 Cancel
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3. Now the current state is stored to the selected Preset. You can see the currently selected preset on the
Beam Preset menu (‘Preset 1: Sunday’ in this case).

Beam Preset

1: Sunday v] [ Store ] [ Clear ]
Power On State: 1: Sunday Select POS...
Dual beam

Comments: Sunday, covering main floor and balcony

4. |If you change any parameter (such as Beam pattern, Beam Gain) from here, the Beam Preset menu

becomes blank. This means that the settings have changed, and the current state of the array has not been
stored to a Beam Preset.

Beam Preset

v [ store |

Power On State: 1: Sunday Select POS...

Dual beam

Comments: Sunday, covering main floor and balcony

Above: Menu becomes blank after changing Beam EQ.
5. Once you store a beam preset(s), you can recall that beam preset from the drop-down list.

Beam Preset

2: Weekday | | store || clear |
1: Sunday
sekdz Select POS...
3
4
g lering main floor only
o
8:
<l
10:
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Power On State

Power On State is a Beam Preset that is automatically recalled right after the power cycle of the array. By
default, the first stored Beam Preset is assigned to the Power On State. The Power On State is indicated
below the Beam Preset menu.

Beam Preset

[2.‘ Weekday v] [ Store ][ Clear ]
( Power On State: 1: Sunday )
Single beam

Comments: Weekday, covering main floor only
You can change the Power On State to a different Beam Preset.
1. Click ‘Select POS..” button

Beam Preset

2 Weekday | | store || ciear

Power On State: 1: Sunday Select POS...

Single beam

Comments: Weekday, covering main floor only

2. Select Power On State dialog box appears. Select the Beam Preset that you want to assign to the Power
On State.

P
! Select Power On State g
Select the beam preset to use for the power on
state.
Preset: | 1: Sunday v
1: Sunda
[ 4
5:
S —
8
9:
10:

3. Click OK. Now the Power On State has been changed.

Beam Preset

2: Weekday v] [ Store ] [ Clear ]
Power On State: 2: Weekday | Select POS... |
Single beam

Comments: Weekday, covering main floor only
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Assignh Beam Preset to Parameter Set

Once you assign Beam Presets for each array, you can recall a Beam Preset by invoking a Parameter set from
other ControlSpace control families (such as CC-64, GPIO, Timer in ESP, ControlSpace Remote). To do this,
you have to assign the Beam Preset to the Parameter set.

Invoke Parameter Set with
ESP/EX-1280C processor L— -cc-64

& - GPI trigger

- ControlSpace Remote
..etc.

Parameter Set

Recall Assign Beam Preset

to Parameter Set

S

Beam Preset

Associate |-

Snapshot of status

MSA12X loudspeaker

Note: You cannot assign each individual Parameter of an MSAI2X device (such as Beam Gain, Beam EQ) to a
Parameter set directly. Only a Beam Preset (which is a 'snapshot’ of the state of the array) can be assigned to
and recalled from a Parameter set.

This operation can be done while Dante is enabled, but cannot be done when CSD is online (blue
background), which is a standard CSD programming procedure. You have to go offline before setting
Parameter sets.

1.  Recall the Beam Preset for the state that you want to assign to a Parameter set.

Beam Preset

|1:Sunday vi | Store || Clear |
2. Weekday y | Select POS...

-

4
E Ing main floor and balcony

n

© 00
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that represents the MSA12X device.

set if needed.

vy

Input 7

v

Input &

W

=3
E

W

=]

Go to the device view of the ESP that the MSA12X device is associated with, and select the output block

Drag that output block into the parameter set tree in the Parameter Set window. Rename the parameter

@ Lefi-Array

ParameterSets

Right clic =reto add an entry.

[+-Param set1 | 2Param Set2 | 3Param. Set3 | 4Param Sei4 | 5Param Set5 | GParam. Set6 | 7-Param Set7 | 8

- Param. ST “Param. Set 1"

4. Select Properties window appears. Select ‘Endpoint properties’. Click OK.

r! Select Properties g

Select the properties for the parameter
set:

(' Dante properties (mute/gain)
@ Endpoint properties

[ OK ] [ Cancel

5. Now the Beam Preset has been assigned to the Parameter set.

. .

Right click here to add an entry.

|8 Param. Set 1. "Param. Set 1"
=- ESP-1240 (RTC): "ESP-1240 17
£ MSA12X: "Left-Array”
. i.Preset™1"
i.. Standby: "False”
B MSA12X: "Right-Array”
. Preset: 1"
... Standby: "False”

|1:Param_ Set1 ’ 2:Param. Set 2 ‘ 3:Param.
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Beam Shaping in CSD

You can set the Beam Shaping within CSD for Basic Steer/Spread without needing Modeler on your PC. This
is helpful when you set the beam in a room that requires only basic steering and spreading without the visual
guide from the Vertical SPL map of Modeler.

1. Click ‘Set... button under Beam.

MSA12X
Lef-Auray
Array Mame in design Beam Gain & EQ Status
Main Left Main Beam 2nd Beam
Standhby: |:|
0.0 0.0 dBE
Input & Speaker EQ dB EErairs
12 12 _
Input: @ Dante ) Analog 0dB - Health: .
L 0 - 0
Beam
Set Beam from CSD
Beam Preset
1: Sunday v] [ Store ] - -
[] Show Beam EQ
Power On State: 1: Sunday Select POS...
Dual beam

Comments: Sunday, covering main floor and balcony

[T] Show beam details

Hardware configuration: Message (See Advanced Window for Details) Advanced

Identify IP Address: 192.168.0.101 | Set_..
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2. Beam Control window appears. Set the Steer angle and Spread angle for each beam. A red wire frame
corresponds to the Main Beam; a blue wire frame corresponds to the Secondary Beam. ‘Vocal Smoothing
Option’ is not available for this tool. Press ‘Set’ when you finish.

m Beam Control ﬁ
BASIC STEER/SPREAD
Main Beam Secondary Beam
Enable
Steer angle (%) -100 & 100 +
Spread angle (7) 50 ¥ 00 %
Set ] [ Cancel

Note: The beam wireframes may look different from those in Modeler, even when the steering (and/or
spreading angle) is the same. This is because in Modeler, a user can specify the Distance (length) of the beam
lines, which does not affect the beam of this beam type. As long as the steering (spreading) angle is identical,
the radiated beam pattern is identical.

3. Now the beam pattern is transferred to the array, and you will be able to hear the change of the beam
pattern. If you like this pattern, store it to a Beam Preset (see page 35).

This function is available when either

The MSA12X device in CSD is already associated to a Physical array.

The MSA12X device in CSD has already received a beam pattern sent fromm Modeler.
Otherwise, the ‘Set...” button is grayed out.

Template Files

Template files will be available on pro.Bose.com to get you started using CSD and Modeler with MSA12X.
These will include arrays for typical systems, including a 2-module Left-Right system with a single beam and
a 2-module Left-Right system with dual beams. If you are new to CSD or Modeler, it is recommended to use
these template files to start your projects.
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Frequently Asked Questions

What is the angular limit for Basic Steering/Spreading?

Array 1-module 2-module 3-module
Steer -20° to +20° -20° to +20° -20° to +20°
Spread 0° to 30° 0° to 30° 0° to 30°
1-module array 2- or 3-module array

Steer: £ 20° Steer: £ 20°
Spread: Up to 30° (x 15°) Spread: Up to 40° (£ 20°)

What is the frequency limit for the beam control?

It depends on the length of the array. The longer the array, the lower the frequency limit for the beam control.
A rough guide is shown below:

1-module array: 500 Hz

2-module array: 250 Hz

3-module array: 160 Hz
How many modules per array are supported?
Up to 3 modules stack per array is supported.
How many modules do | need for the dual beam?

Regardless of number of modules of an array, up to two beams (single beam or dual beam) can be radiated. It
is recommended to use a 2- or 3-module MSA12X array for better directivity control due to the longer array.

How many beams can be radiated from one array?

Currently, up to two beams per array (dual beam) are supported.

Do | need a power amplifier for driving a MSA12X array?

No. MSA12X is a powered loudspeaker with amplifiers in it, and you do not need additional power amplifiers.
Does MSA12X have DSP inside? Do | need an external signal processor?

MSA12X has on-board DSP inside, which manages Speaker EQ, beam shaping, beam gain and Beam EQ. If you
need to apply more signal processing such as Room EQ or signal delay for rear arrays, you need an additional
signal processor such as Bose ESP in the upstream of the system.
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What EQ options does MSA12X offer?

MSA12X has 2 layers of EQ in its on-board DSP. First, it has an on-board Speaker EQ, with a Music and Speech
option that updates for -module, 2-module and 3-module arrays. This provides the basic sound profile for
MSA12X and the Music setting closely matches the MA12EX sound profile. Second, there is Beam EQ which
compensates for the tonality change when spreading is applied. Beam EQ is automatically applied by the
beam shape and this can be viewed and edited in the CSD MSA12X control panel. And optionally, a third layer,
room EQ can be added to correct for room problems. This EQ is manually added as blocks in a DSP such as
ESP-880/1240/4120/1600 or ControlSpace EX-1280C. Template CSD files include the recommended room EQ
blocks for CSD.

Do | need Speaker EQ on external signal processor?
No. MSA12X has an on-board Speaker EQ, which you can choose from ‘Music’ or ‘Voice’.
What is possible with/without a ControlSpace ESP, with/without Dante® Card?

ESP* with Dante Card, ESP* without No ESP
ControlSpace EX Dante Card in the System
Input Signal Dante or Analog Analog Analog
Beam Pattern Change** via Yes NOT SUPPORTED No
CC-64 and Bose wall controls
Beam Pattern Change** via Yes NOT SUPPORTED No
ControlSpace Remote (CSR)
Beam Pattern Change** via Yes NOT SUPPORTED No
Timer
Beam Pattern Change** via Yes NOT SUPPORTED No
GPI
Toggle Stand-by via Bose wall Yes NOT SUPPORTED No
panels, CSR, Timer, GPI
Dual Beam Yes No No
Room EQ, delay Use ESP* or Use ESP* Requires 3rd
ControlSpace EX party processor
* ControlSpace ESP-880, ESP-1240, ESP-4120, ESP-1600 engineered sound processors
** Includes Dante/Analog input, input gain, Beam EQ settings

What is the input signal type?
Dante input and balanced analog input are supported.
Can | use Dante redundancy with MSA12X?

MSA12X array has only one RJ-45 input, and Dante redundancy is not supported. Note that for a multi-module
array, you cannot use RJ-45 input(s) that belongs to slave module(s). Only the RJ-45 input on the master
module can be used for the entire array.

Can | switch Dante/Analog input without a PC?

Yes. To do this, you need an ESP (with Dante Card) or EX-1280C in the system. Input type (Dante/Analog) can
be stored in the beam presets. Once you set up the beam pattern, first store that beam pattern to one of the
beam presets, with ‘Dante’ selected for the beam type. Then switch the input type to ‘Analog’, and store that
state to another beam preset. Assign these beam presets to Parameter sets in ESP/EX-1280C. You can now
switch between Dante input and Analog input using the Parameter sets.

Automatic failover is not supported.
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Can | assigh Beam gains to controls such as CC-64 or ControlSpace Remote?

You cannot assign beam gains in the main window of MSA12X device view. In order to achieve the same
functionality, you need a supported ControlSpace processor. Insert a gain block in the signal chain in the ESP
(with Dante® Card) or EX-1280C and assign that gain block to the controls.

Can the ControlSpace ESP-00 processor be used to support MSA12X?

You can use ESP-00 and MSA12X in the same system. However, ESP-0O0 does not support association with
MSA12X. i.e. you cannot use Parameter Set via ESP-00 for invoking Beam Preset of a MSA12X array.

Can | use the beam shaping functionality from CSD?

Yes, with a specific beam type. In CSD, you can use ‘Set beam from CSD’, which enables you to setup basic
steering/spreading on site without needing Modeler.

Can | use rear arrays? When do | need rear arrays?

You can use rear arrays just like when you design your system with line arrays such as MA12 or MA12EX. This
will depend on the room shape and beam pattern that you design. It is recommended to use the Modeler SPL
map and evaluate the acoustic performance based on the prediction.

Can | mix & match MSA12X with other Bose modular columnar arrays?

Yes. MSA12X is a member of the Bose modular line array family, which includes MA12 and MA12EX. For
example, if you do not need to digitally steer the beam for rear arrays, you can use other passive modular line
arrays with an amplifier (e.g. MA12 with a PowerMatch).
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Appendix: How to Set Up IP Address

We recommend having a router or DHCP server in the system for setting up, which will make the setup
process simple and easy. However there will be cases where you do not have a router/DHCP server. This
appendix shows example IP setting processes for typical situations.

For more complex Network settings, please contact the IT representative personnel.

Note: Dante® Controller must be installed on your PC (download: https://www.audinate.com/).

With EX-1280C or 1U ESP with Dante® Card, No Router
1. Connect PC and all the devices to the network.

2. Set IP of PC to DHCP.

3. Launch Dante Controller.

a. Make sure all the Dante Devices (incl. MSA12X arrays, ESP) appear.

b. At this point, all the Dante Devices should be

i.  IP:169.254.XXX.XXX
ii. Subnet Mask: 255.255.0.0

pC == - Switch F
DHCP I
IP: 169.254 X XX. XXX :
Subnet: 255.255.0.0 I
Dante Card
DHCP

IP: 169.254 . XXX. XXX

Subnet: 255.255.0.0

DHCP
IP:192.168.0.160
Subnet: 255.255.255.0

ESP

4. Change IP of all the Dante devices to static:
i. 1P:192.168.0.xxx (e.g. 101,102, ...)
ii. Subnet Mask: 255.255.255.0

Each time you change the IP, that Dante device may disappear in the Dante Controller, or even if it can be
seen, you may not be able to assign Dante subscriptions. This is OK.

pPC_ = |- - Switch |-—-
DHCP T — =
IP: 169.254 . XXX. XXX .
Subnet: 255.255.0.0 I

Dante Card

Static
IP: 192.168.0.101
Subnet: 255.255.255.0

DHCP
IP:192.168.0.160
Subnet: 255.255.255.0

ESP

: MSA12X

I DHCP
. IP: 169.254 . xxX. XXX
I Subnet: 255.255.0.0

.— [ MSA12X

DHCP
IP: 169.254 .XXX. XXX
Subnet: 255.255.0.0

Dante Device IP automatically
given by Dante link local

MSA12X

I Static
. IP:192.168.0.102
| Subnet: 255.255.255.0

P—- MSA12X

Static
IP: 192.168.0.103
Subnet: 255.255.255.0

Last 3 digits of IP (bold)
are just examples

Design Guide - 45



Appendix: How to Set Up IP Address

5. Change IP of PC to 192.168.0.10, Subnet mask 255.255.255.0.

PC —-—-—| Switch p-—-—" — =
Static T -t | MSA12X
IP: 192.168.0.10 . I
Subnet: 255.255.255.0 I . Static
I IP: 192.168.0.102
Dante Card : Subnet: 255.255.255.0
N |
Static .
IP: 192.168.0.101 I
Subnet: 255.255.255.0 |
DHCP . MSA12X
IP: 192.168.0.160 :
. Static
Subnet: 255.255.255.0 1P 192 168.0.103
ESP Subnet: 255.255.255.0

6. Launch CSD. Now BMW arrays appear in the Project View.
a. If not, go to System > Enable Dante Control.

b. If MA12X arrays still do not appear, make sure the right Network Interface Card (NIC) is selected for
CSD. You can see the current NIC from the top menu: System > Host NIC Setup.

7. Scan ControlSpace Network. Now ESP with Dante Card appears.

a. If not, make sure the Project Network Address is 192.168.0.xxx. You can set this by selecting Tools > Set
Project Network Properties.

b. By default, the IP of ESP is 192.168.0.160.
8. Set the IP setting of ESP from DHCP enabled to static.

PC e ¢ - ¢ - SWItCh T
Static T | MSAT2X
IP: 192.168.0.10 . .
Subnet: 255.255.255.0 | | Static
: IP: 192.168.0.102
Dante Card : ‘ Subnet: 255.255.255.0
Static |
IP: 192.168.0.101
Subnet: 255.255.255.0 | _l MSA12X
Static Static
IP: 192.168.0.160 IP: 192.168.0.103
Subnet: 255.255.255.0 Subnet: 255.255.255.0
ESP
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With 1U ESP without Dante® Card, Analog Input to MSA12X, No Router

1. Connect PC and all the devices to the network.

2. Set IP of PC to DHCP.
3. Launch Dante Controller.

a. Make sure all the Dante Devices (incl. MSA12X arrays) appeat.
b. At this point, all the Dante Devices should be

i.  IP:169.254.XXX.XXX

ii. Subnet Mask: 255.255.0.0

PC

DHCP

IP: 169.254 XXX. XXX
Subnet: 255.255.0.0

Switch ="

DHCP
IP:192.168.0.160
Subnet: 255.255.255.0

ESP (no Dante Card)

4. Change IP of all the Dante devices to static:
i. 1P:192168.0.xxx (e.g. 101,102, ...)
ii. Subnet Mask: 255.255.255.0

Each time you change the IP, that Dante device may disappear in the Dante Controller, or even if it can be
seen, you may not be able to assign Dante subscriptions. This is OK.

PC

DHCP

IP: 169.254 . XxX. XXX
Subnet: 255.255.0.0

Switch p-=—-

DHCP
IP:192.168.0.160
Subnet: 255.255.255.0

ESP (no Dante Card)

| MSA12X

I DHCP

. IP: 169.254 xXX. XXX
| Subnet: 255.255.0.0

MSAT12X

DHCP

IP: 169.254 xXX. XXX
Subnet: 255.255.0.0

Analog input for MSA12X (Audio Signal)

| MSA12X

| Static
: IP: 192.168.0.101
! Subnet: 255.255.255.0

MSA12X

Static
IP: 192.168.0.102
Subnet: 255.255.255.0

Last 3 digits of IP (bold)
are just examples
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5. Change IP of PC to 192.168.0.10, Subnet mask 255:255:255.0.

pCc e _ = Switch [r=r=:=":=-
Static I ; MSA12X
IP: 192.168.0.10 . |
Subnet: 255.255.255.0 | I Static
. IP: 192.168.0.101

DHCP I .

P 192 168.0.160 I Subnet: 255.255.255.0

Subnet: 255.255.255.0 MSA12X

ESP (no Dante Card) .
Static

IP:192.168.0.102
Subnet: 255.255.255.0
6. Launch CSD. Now MSA12X arrays appear in the Project View.
a. If not, go to System > Enable Dante Control.

b. If MA12X arrays still do not appear, make sure the right Network Interface Card (NIC) is selected for
CSD. You can see the current NIC from the top menu: System > Host NIC Setup.

7. Scan ControlSpace Network. Now ESP appears.

a. If not, make sure the Project Network Address is 192.168.0.xxx. You can set this by selecting Tools > Set
Project Network Properties.

b. By default the IP of ESP is 192.168.0.160.
8. Set the IP setting of ESP fromm DHCP enabled to static.

PpC e _ = Switch F- == =.—=.
Static I | MSA-|2X
IP: 192.168.0.10 . !
Subnet: 255.255.255.0 I I Static
. . IP: 192.168.0.101

Static I Subnet: 255.255.255.0

IP: 192.168.0.160 _—

Subnet: 255.255.255.0

ESP (no Dante Card) MSAI12X
Static

IP:192.168.0.102
Subnet: 255.255.255.0

9. Make sure to change the input type of each MSA12X device to Analog.

Note: Dual beam option cannot be used when the input is Analog. Without a Dante Card, you cannot change
the beam pattern by invoking a beam preset via Parameter-set.
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Without ESP/EX-1280C, Analog Input to MSA12X, No Router

MSA12X is a Dante device. Even if you do not use Dante connection for sending audio signal, the beam
configuration setup is performed through Dante Network, and you have to setup IP of PC and MSA12X.

1. Connect PC and all the devices to the network.

2. Set IP of PC to DHCP. At this point, you may not be able to see MSA12X in CSD, since Project Network
Address is still 192.168.0.xxx.

3. Launch Dante Controller.
a. Make sure all the Dante Devices (incl. MSA12X arrays) appeat.
b. At this point, all the Dante Devices should be
i IP:169.254 xxX.xxX
i. Subnet Mask: 255.255.0.0

PC ----- — SW'tCh e & e o o
DHCP : MSA12X
IP: 169.254 . XXX.XXX !
Subnet: 255.255.0.0 Project Network Address of CSD | DHCP
192.168.0.xxx by default . [P: 169.254 . xXXX.XXX
| Subnet: 255.255.0.0
MSAT12X
Analog input for MSA12X (Audio Signal) DHCP

IP: 169.254 XXX.XXX
Subnet: 255.255.0.0
4. Change IP of all the Dante devices to static:
i. 1P:192.168.0.xxx (e.g. 101,102, ...)
ii. Subnet Mask: 255.255.255.0

Each time you change the IP, that Dante device may disappear in the Dante Controller, or even if it can be
seen, you may not be able to assign Dante subscriptions. This is OK.

PC ----- — SWltCh e & e o o
DHCP i MSAI2X
IP: 169.254 . XXX.XXX .
Subnet: 255.255.0.0 Project Network Address of CSD | Static
192.168.0.xxx by default . IP: 192.168.0.101
! Subnet: 255.255.255.0
MSA12X

Last 3 digits of IP (bold)
are just examples Static

IP: 192.168.0.102
Subnet: 255.255.255.0
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5. Change IP of PC to 192.168.0.10, Subnet mask 255:255:255.0.

pC k== Switch == =.—.

Static I ; MSA12X
IP: 192.168.0.10 |

Subnet: 255.255.255.0 I Static

. IP: 192.168.0.101
1 Subnet: 255.255.255.0

MSA12X

Static
IP: 192.168.0.102
Subnet; 255.255.255.0

6. Launch CSD. Now MSA12X arrays appear in the Project View.

a. If not, make sure the Project Network Address is 192.168.0.xxx. You can set this by selecting Tools > Set
Project Network Properties.

b. By default, the IP of ESP is 192.168.0.160.

7. You can set up the beam properties of MSA12X without ‘Go Online...” in CSD, as long as the Dante Control
and Endpoint Control are enabled.

8. Make sure to change the input type of each MSA12X device to Analog.

If you do not have a network switch in the system, connect your PC to each MSA12X directly, and repeat the
above process for each array.

Note: You cannot change the beam pattern via a beam preset without a TU ESP (ESP-880/1240/4120/1600)
with Dante Card, or ControlSpace® EX-1280C in the system.
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